# Table of Contents

1. Introduction .................................................................................. 1
   1.1. System Requirements ............................................................... 2
   1.2. Sensor Fundamentals ............................................................... 3
   1.3. Installing the Software ............................................................ 3
   1.4. Licensing the Software ........................................................... 4

2. Recording ..................................................................................... 6
   2.1. Starting SCENECT ................................................................. 6
   2.2. Opening a Scan Project .......................................................... 6
   2.3. The SCENECT Toolbar and Menu ......................................... 7
   2.4. Live Tracking ......................................................................... 9
       2.4.1. Settings ........................................................................... 9
       2.4.2. Tracking .......................................................................... 12
   2.5. Tracking Frames from Recorded Video Files ....................... 15
       2.5.1. Settings ......................................................................... 15
       2.5.2. Tracking from File .......................................................... 15
   2.6. Workspace Structure ............................................................. 16

3. Post Processing ............................................................................ 17
   3.1. Viewing the Recorded Results .............................................. 17
       3.1.1. Viewing Frames with the Planar View and the Quick View ... 17
       3.1.2. Viewing Scan Points with the 3D View ............................. 18
   3.2. Applying Additional Registration Steps to the Frames of a Sequence .................................................................... 19
   3.3. Color Smoothing ................................................................. 20
   3.4. Deleting Scan Points ............................................................ 21
   3.5. Registering Sequences .......................................................... 22
       3.5.1. Registration with Reference Objects .................................. 23
       3.5.2. Correspondence View ..................................................... 30
   3.6. Creating a Project Point Cloud ............................................. 33
   3.7. Analyzing the Scanning Results .......................................... 35
   3.8. Exporting ............................................................................ 35

4. Calibrating the Sensor ................................................................. 36

5. Hints & Tips ............................................................................... 37

Software License Agreement ................................................................ 37

Implementation Notes ........................................................................ ii
   Apache ....................................................................................... ii
   paintlib Library .......................................................................... iii
   LibTIFF Library .......................................................................... iii
   JPEG Library ........................................................................... iii
   KissFFT Library ........................................................................ iv
   Open Source Computer Vision Library ...................................... iv
   GPL (GNU General Public License) ........................................... iv
   LGPL (GNU Lesser General Public License) ................................ x
   GEOTRANS ............................................................................ xii

Trademarks ..................................................................................... xii
1. Introduction

The SCENE software family is a comprehensive 3D point cloud processing and managing software for the professional user. It is specially designed for the viewing, administration, and working with extensive 3D scan data obtained from high resolution 3D laser scanners like the FARO Focus\textsuperscript{3D}. THE SCENE software family consists of SCENE and SCENE LT.

While SCENE offers the complete functionality to view, administrate, process, register and analyze laser scans, SCENE LT is a free point cloud viewing software that mainly enables the user to view and analyze the laser scans. It also offers some basic functionality to process the laser scans and to export them into different file formats.

SCENECT covers all the functions of SCENE LT and, additionally, enables anyone with the Microsoft\textsuperscript{®} Kinect\textsuperscript{TM} for Windows, the Microsoft Kinect for Xbox\textsuperscript{®} or the ASUS\textsuperscript{®} Xtion Pro Live\textsuperscript{i} to capture objects and environments in 3D in real-time. Along with the functions of SCENE LT you are then able to view, process and analyze the recordings obtained from these two devices as well as to export them into different file formats for further use in third party applications, like CAD programs. Due to the sensors being designed as a gaming hardware, not too much accuracy should be expected, although the results can already be impressive.

Please note that SCENECT is a technology preview. It is provided to you “as is” at no charge and without warranty of any kind. It should be regarded as a testing ground for new services and products and is therefore still in testing phase. It has not been released for sale and will be referred to as beta software from here on and should not be used on sensitive and/or valuable data. In no event will the licensor be liable for damages arising out of the use or inability to use the software. SCENECT is not supported by FARO Customer Service. For more information, see Software License Agreement on page i.

This manual will give you an overview of the functions that are necessary to record and process data obtained from the two supported sensor devices. It will guide you through the steps of capturing objects and environments with the Kinect or the Xtion and of postprocessing the resulting 3D point clouds. Functions that are part of SCENE LT and that are mainly required for processing and analyzing the recorded point clouds will be roughly described in this document. Detailed information may be found in the online help of SCENECT (under Help ➤ Contents) or in the SCENE manual (available in the Start Menu of Windows after installing SCENECT).

Watch tutorial videos on YouTube to learn more about recording and processing data with SCENECT: SCENECT Tutorials

\textsuperscript{i} Reference to any ASUS products, services, processes, or other information and/or use of ASUS Trademarks does not constitute or imply endorsement, sponsorship, or recommendation thereof by ASUS.
### 1.1. System Requirements

**Sensor specific hardware and software requirements:**

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>Asus Xtion Pro Live (with RGB and depth sensor)</th>
<th>Microsoft Kinect for Windows or XBOX</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No extra power supply needed.</td>
<td>Kinect Power Supply adapter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(included with the Microsoft Kinect for Windows, not included with the Microsoft Kinect for XBOX)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This adapter consists of a dedicated power plug and USB cord and splits the connection into separate USB and power connections thus providing power to the sensor and connectivity to your computer.</td>
</tr>
</tbody>
</table>

**Drivers**

- OpenNI 1.5.4
- SensorPrimesense driver (version 5.1.2.1)
- OpenNI 1.5.4
- SensorKinect driver (version 5.1.2.1)

If these drivers are not available on your system, they will automatically be installed when installing SCENECT (if enabled during installation). For more information, see chapter 1.3.

**Computer specific hardware requirements:**

<table>
<thead>
<tr>
<th></th>
<th>Minimal Specifications</th>
<th>Recommended Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
<td>Double-Core 64-bit (x64) with at least 2-gigahertz (GHz)</td>
<td>Quad-core x64</td>
</tr>
<tr>
<td><strong>Graphics Card</strong></td>
<td>• Must support OpenGL 2.0 or higher</td>
<td>• Dedicated graphics card</td>
</tr>
<tr>
<td></td>
<td>• At least 256 MB memory.</td>
<td>• At least 512 MB memory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OpenGL 2.0 support</td>
</tr>
<tr>
<td><strong>Main Memory</strong></td>
<td>At least 4 GB</td>
<td>At least 8 GB</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td>Standard</td>
<td>Solid state for maximum performance.</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows XP, Vista or 7 (64bit versions)</td>
<td>64-bit Windows 7</td>
</tr>
<tr>
<td><strong>Misc.</strong></td>
<td>• Mouse with 2 buttons and a scroll wheel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Network card as it is required for licensing SCENECT</td>
<td></td>
</tr>
</tbody>
</table>
1.2. Sensor Fundamentals

The Kinect and the Xtion feature an RGB camera and a depth sensor.

The depth sensor consists of an infrared laser projector combined with a monochrome CMOS sensor, which captures video data in 3D by means of triangulation of coded light. As structured light is used for depth measurement, bright ambient light might reduce the measurement range.

Both devices feature microphones and the Kinect a motorized pivot. They are not used by SCENECT.

1.3. Installing the Software

You need administrator rights in order to install the software.

1. Unplug the sensor device from your computer.
2. Start the SCENECT setup file.
3. Follow the instructions on the screen.
4. On the Select Additional Tasks screen, make sure to enable Install Kinect and Xtion drivers if the required versions of the OpenNI library and the sensor drivers are not installed on your system. See chapter 1.1 for more information on the required driver versions.

Previous driver versions will be replaced by the SCENECT setup. If later versions are installed, uninstall them first and re-install the drivers with the SCENECT setup.
Figure 1-2: Installation – Select Additional Tasks

5. When installing the drivers, a security note from Windows might appear. Please confirm it.

6. Reboot your system after installation.

7. Connect the sensor device to the computer:
   - **Kinect**:
     1. Plug the cable from the Kinect sensor into the connector of the power supply adapter.
     2. Plug the AC adapter end of the power supply adapter into a wall outlet.
     3. Plug the USB cable of the power supply adapter into the USB port of your computer.
   - **Xtion**: Plug the USB cable of the XTION into the USB port of your computer.

The setup will also install demo data (raw data video files) into your personal documents folder under C:\Users\YOUR_USER_NAME\Documents\FARO. See chapter 2.5 for more information on how to use them.

1.4. Licensing the Software

Once SCENECT has been installed, you may use it for 30 days without a license key. After this trial period, you need a license key to further use the software. **This license is free of charge.** To license the software follow the steps below:

1. Request the free license key from FARO with the license manager (available in the main menu under Help ▶ Licensing).
2. In the license manager, press the Send button to generate a license request file (this file does not contain any private data, it only contains the product name and your system ID generated from the MAC address of your network adapter).

- If an E-Mail client is properly installed on your system an automatically generated E-Mail with the license request file attached will be opened. Send this E-Mail to the provided address.

- In case an E-Mail client is not installed, manually send the generated license request file to FARO. Find this file in your local user folder under C:\Users\YOUR_USER_NAME\AppData\Local\FARO\SCENE\Data\Licensing. It is the file with the extension .lr. Attach it to an E-Mail and send it to: SCENE-Licensing@faroeurope.com

3. Once the mail with the license request file has been sent to FARO, you will receive an automatic reply with a valid license key. Copy this key to the Add new license field in the license manager, press the Add button, and then OK or Apply. SCENECT should then be licensed for your system and its license should appear in the list. It is valid for one year and must be renewed when it has expired.

**Please note:** If you change your hardware or if you want to use SCENECT on a different computer, you will need a new license, as the license is bound to a system ID.
2. Recording

2.1. Starting SCENECT

On the first program start, SCENECT asks you to set up a default project folder. Afterwards, SCENECT starts with the Project Selector window by default which presents all the scan projects known to SCENECT at that time.

![Figure 2-1: Project Selector Window](image)

For more information on the Project Selector, see chapter “Working with the Project Selector” in the SCENE manual or in the online help. The SCENE manual was installed with SCENECT and is available from the Start Menu of Windows. The online help is available in SCENECT under Help ▶ Contents.

2.2. Opening a Scan Project

SCENECT needs to know where to save your recorded scan files before recording: Open an already existing scan project or create a new scan project.

Create a new project

- with the project button 📊 in the standard toolbar,
- in the main menu under File ▶ New ▶ Project,
- or with the New Project button 📚 in the Project Selector.

For more information on working with scan projects, please see chapter “Working with Scan Projects” in the SCENE manual or online help.
Once a scan project is opened, the typical SCENECT window appears. This window is made up of the following areas:

1. **Main menu** – contains all the menus with commands for general operation.
2. **Toolbars** – provides common menu features.
3. **Structure view** – displays the structure of the project workspace, including all folders, recorded sequences, recorded frames and other objects.
4. **Status bar** – displays command and scan point data details.
5. **Scan and object views** – the visual presentation of the recorded scan data and other objects. Scans and objects can either be displayed in a quick view, a detailed planar view or in 3D view. The views can be displayed in **tabbed** or **unanchored** windows. Tabbed windows are the standard display option and allow maneuvering between multiple windows by clicking at the tabs on top of this area. Change this under **View > Tabbed Documents**.

2.3. The SCENECT Toolbar and Menu

The SCENECT toolbar should be visible by default. In case not, toggle its visibility in the main menu under **View > Toolbars**.
Live Tracking Button - Immediately starts the recording from the connected sensor device. If a scan project is not open yet, you will be prompted to create one first. For more information, see chapter 2.2. Clicking the arrow on the right will bring up this drop down menu with further options:

![Start Live Tracking](F5)
![Live Tracking - Settings](F5)

**Figure 2-4: Drop Down Menu Live Tracking**

- **Start Live Tracking** – Same functionality as clicking on the button above.
- **Live Tracking - Settings** – Opens the settings dialog for the live tracking. For more information, see chapter 2.4.1.

Tracking from File - Starts tracking of frames from a raw data video file (video that contains depth and color information) of a previous recording. For more information, see chapter 2.5. The arrow brings up this drop down menu with further options:

![Start Tracking from File](Ctrl-F5)
![Tracking from File - Settings](F5)

**Figure 2-5: Drop Down Menu Tracking from File**

- **Start Tracking from File** – Same functionality as clicking on the button above.
- **Tracking from File - Settings** – Opens the settings dialog for the file tracking. For more information, please see chapter 2.5.

Make Snapshot - Only available during live tracking or tracking from raw data video files. It enables you to create a snapshot frame from your recording whenever you want.

Stop Tracking - Stops live tracking or tracking from a video file.

![SCENECT Menu](F5)

**Figure 2-6: SCENECT Menu**

The SCENECT menu covers the functionality of the toolbar plus additional functions:

- **Tracking from Sequence File** - Track frames from the raw data video of the sequence that is currently selected in the structure view. For more information, see chapter 2.5.
- **Coarse Registration** - Applies coarse registration to the frames of the sequence that is currently selected in the structure view. For more information, see chapters 2.4.1 and 3.2.
Loop Registration - Applies loop registration to the frames of the sequence that is currently selected in the structure view. For more information, see chapters 2.4.1 and 3.2.

Fine Registration - Applies additional registration steps to the frames of the sequence that is currently selected in the structure view. For more information, see chapters 2.4.1 and 3.2.

Smooth Color - Smooths the color scan points in overlapping areas within the selected sequence. For more information, see chapter 2.4.1 and 3.3.

Calibration - Start calibration of your sensor. For more information, see chapter 4.

Print Calibration Pattern – A4 / Print Calibration Pattern USLetter – Print a calibration pattern (in DIN A4 or US Letter format). One of these patterns is needed for sensor calibration.

You should calibrate your sensor at least once before starting to use it with SCENECT. Calibration might increase tracking quality and color accuracy of your sensor device.

Quick Start Guide - Opens the SCENECT quick start guide.

SCENECT Manual - Opens this document.

2.4. Live Tracking

As described in chapter 1.2 the Microsoft Kinect and the ASUS Xtion consist of two sensors, a standard RGB camera and a depth sensor. The data obtained from these sensors is used to track the motion of the device and to create the colored 3D point clouds of objects and environments.

While recording the data, the sensor device has to be moved along or around the object of interest. While it is moved, the device’s motion is tracked by means of distinctive features dynamically identified in the recorded data; the pose of each recorded frame is estimated by registration against its previous frame (frame-to-frame tracking). The pixels or points of the recorded frames which contain depth information from the depth sensor and color information from the RGB camera are used to build up the colored 3D model of the captured object(s). To reduce data size, only key frames which are selected by certain criteria are picked from the data stream and used for the 3D model.

You should calibrate your sensor at least once before starting to use it with SCENECT. Calibration might increase tracking quality and color accuracy. For more information, see chapter 4.

2.4.1. Settings

Before starting live recording, you may change the settings used for recording and processing of the captured data.

Open the settings dialog via Live Tracking – Settings from the SCENECT main menu or from the drop down menu of the Live Tracking button in the toolbar.
Sequence Name – A sequence contains all the data of one single recording. It contains key frames, snapshots, the recorded raw data video and the device’s trajectory as well as a sequence protocol. A sequence is organized as a folder in the project’s workspace. This folder will be named according to the name provided in this dialog.

Sequence names may not contain special characters or blanks.

Track Frames – Enable to capture key frames in real-time while recording. You can also track frames offline at a later time from a recorded raw data video (see below for more information).

Record Video – Enable to save the raw data video for later offline capturing of the frames. This raw data video contains all the depth and color information obtained from the device’s sensors. For more information, see chapter 2.5.

Tracking frames in real-time has increased system requirements. If you are tracking frames in real-time on a system with lower performance (e.g. tablet), frame-to-frame tracking might be less accurate. In this case, you may record the raw data video only and track the frames from the video later. See chapter 2.5 for more information.

But as tracking frames in real-time has the advantage of enabling you to recognize whether tracking gets lost and whether all objects are captured, it is recommended to enable it, even on systems with lower performance. In this case, it is recommended to record the video too and re-track the frames from the video later. This might improve the accuracy of the frame-to-frame tracking.

Max. Range – Limit the maximum recording range. Objects within this range will be captured; objects that are farther away won’t be part of the resulting 3D point cloud.

The minimum depth sensor range of the ASUS Xtion and the Kinect is 0.8m; it depends on ambient illumination whether closer objects are recognized. The specified maximum range of the depth sensor of the devices is 4 meters. You might get depth data from objects that are farther away, but quality and accuracy may decrease noticeably at distances beyond this limit.

Color Mismatch Filter – If there is an object in the foreground which differs from the background color there might be some mismatch between the color of the background and foreground and the 3D model points at the edges of that object. This mismatching comes from...
accuracy limitations of the Kinect and Xtion devices. The edge of the foreground object is smeared with the background color and vice versa. This filter attempts to detect such situations and removes the critical points from the model.

![Image of two book covers with text: "Figure 2-8: Left: No color mismatch filter applied, right: Color mismatch filter applied"](image)

**Coarse Registration** – Applies a global bundle adjustment to the recorded sequence and tries to distribute alignment errors evenly across the frames of the sequence to minimize major inconsistencies. Coarse registration will automatically be applied if loop registration is enabled. Select this option, if you want to apply coarse registration to the frames of the recorded sequence without loop registration.

**Loop Registration** – Applies loop registration, and afterwards coarse registration (see above) to the frames of the recorded sequence. Loop registration is an additional registration step which aligns non-consecutive frames to each other if they have overlapping areas. This is, for example, very useful if you are planning to record in a loop (e.g. around an object) where first and last frames have overlapping areas. Note: only overlapping areas of frames with the sensor pointing to the same direction will be taken into account; overlapping areas between frames resulting from opposite viewing directions (e.g. from the right and the left side of an object) will not be taken into account.

**Fine Registration** – As the initial registration by means of pairwise pose estimates between frames (frame-to-frame tracking) might be prone to a rapid accumulation of errors, a bundle adjustment is simultaneously applied to the captured key frames to improve their alignment. These registration steps are done on the basis of recognized features. However, you may apply fine registration afterwards which tries to further improve the registration from frame to frame on the basis of the scan points. This additional registration step is called fine registration. Enable this option if you want to apply fine registration immediately after the recording. Note that fine registration might take some time depending on the number of captured key frames.

Unlike the registration that is done during recording, fine registration attempts to refine the initial placement of the frames by analyzing the 3D scan points between successive frames. The placement is done on the basis of the 3D data only, color values are not taken into consideration. Fine registration might take some time depending on the number of frames.

If the recorded scene does not have sufficient 3D structures or the 3D points are significantly inaccurate, fine registration might not lead to satisfying results. Thus, it is recommended to limit the scan range to a maximum of 2.5 meters, scan points beyond that range might worsen the registration results. In all cases it is recommended to save your project before applying fine registration. You may then return to the saved state of your project if fine registration did not bring the expected results.

> It is recommended not to apply fine registration immediately after recording as it does not always improve registration. You should apply fine registration later, and then
verify its results. If they are not satisfactory you will be able to discard the changes made by the fine registration.

The above mentioned registration steps can also be applied later. For more information, see chapter 3.2.

**Smooth Color** – Applies a color averaging algorithm to the scan points of overlapping areas between frames of the completed sequence. In most cases, this will remove differences in brightness between overlapping areas and improve the overall color impression of the point cloud. Color smoothing can also be applied later. For more information, see chapter 3.3.

**Start** – Save your settings and start live tracking.

**Cancel** – Discard unsaved changes and close the settings dialog.

**Apply** – Save your changes. To close the settings dialog without starting live tracking, press cancel afterwards.

### 2.4.2. Tracking

To get best results, take care of the following before and while you are recording:

- Make sure your device is connected to your computer and – if you are using the Microsoft Kinect – that it is connected to the power supply.
- When tracking frames in real-time, power management of your system should be set to maximum performance (with Windows 7: Control Panel > Hardware and Sound > Power Options: select “High Performance”).
- Make sure that the object of interest is within the specified maximum range and that it is not closer than the minimum range of the sensor (see 2.4.1 for more information).
- Stable tracking requires objects and environments that have enough color structure. Avoid having only plain-colored surfaces in the device’s field of view.
- Move the device slowly and constantly, avoid jerky movements. Fast and jerky movements may lead to inaccurate data or lost tracking.
- Objects should not move while they are captured.
- Ambient light conditions: In scenes with too bright illumination (close to lights or outdoors), the sensor will produce no 3D data or only data with a limited distance range.
- Keep an eye on the quality indicator of the progress dialog (more information below).
- If the number of features gets critical, try to move the device’s field of vision to areas with more structures.
- If you want to record more than one sequence and if you want to put them in a spatial relationship (this step is called registration), make sure that the two sequences taken immediately before and after the current sequence have enough overlap. For more information, see chapter 3.1.

### 2.4.2.1. Starting Tracking

Start live tracking with

- the **Live Tracking** button in the toolbar,
- the **Start** button in the **live tracking – settings** dialog
- or with **F5** on your keyboard.
If the ASUS Xtion and Microsoft Kinect drivers have been installed properly and the device is connected to your computer, tracking should start immediately; the sequence folder will be added to the workspace and a split window will show up with the point cloud of your recording on the left and the video picture on the right as well as the progress dialog.

2.4.2.2. During Tracking

![Figure 2-9: Live tracking – Split screen](image)

The **video screen** on the right shows the RGB camera’s field of view. The green, yellow and red crosses in this view symbolize recognized features used for tracking. Their quality is indicated by their color:

- **Cyan**: New recognized features.
- **Green**: Good features used for tracking.
- **Yellow**: Recognized features that are not yet used but are good candidates for tracking.
- **Red**: Features recognized but not good enough for tracking.

If the number of features gets below a certain threshold tracking is not possible anymore and gets lost. Please make sure to have enough features in the field of view.

The **3D view** on the left shows the point cloud of your captured area. It will build up in real-time. You are able to navigate in the point cloud during tracking.

The **progress dialog** shows the number of frames, some status messages and the overall quality of the tracking:

![Figure 2-10: Progress dialog](image)
Quality - Indicator for the tracking quality:

**Green**: both quality criteria are within the limits: there are enough structures available and the movement of the device is not too fast.

**Yellow**: at least one of both quality criteria is below a certain threshold. You should keep an eye on the number of recognized features and the movement of the device.

**Red**: at least one of both quality criteria is critical and tracking is on the verge of getting lost.

**Status** – Shows current and past status messages (general info and warnings).

**Follow Camera** – Enable to update the camera position in the 3D view according to the current sensor position. If you want to navigate in the 3D view while recording you should disable this feature.

### 2.4.2.3. Stop Tracking

Stop tracking at any time with the

- **ESC** key on your keyboard
- or with the **Stop** button in the SCENECT toolbar or in the progress dialog.

### 2.4.2.4. Resume Tracking

If tracking gets lost (e.g. by too fast movement or not enough recognized features), you may **resume** it.

If tracking got lost, the video screen will change according to the screenshot below.

![Figure 2-11: Resume tracking](image)

On the bottom right you will see the last video frame before tracking got lost. Try to align the sensor so that the current field of view approximately matches the last frame. The red and green crosses in the live video picture help you to get the correct alignment. Try to move the sensor so that both crosses match, tracking should then resume automatically.

If you are not able to resume tracking, you may start from the beginning or continue from the position where tracking got lost by starting a new sequence. Be aware that the new and the previous sequences are initially not linked to each other and that they have to be put in a spatial relationship in order to get a comprehensive point cloud. Therefore, make sure that there is enough overlap between them. For more information, see chapter 3.5.
2.5. Tracking Frames from Recorded Video Files

2.5.1. Settings

Before starting with tracking frames from a raw data video file, you may change the settings. Select Tracking from File – Settings from the drop down menu of the Tracking from File button in the SCENECT toolbar. The settings dialog will show up:

![Tracking from File - Settings](image)

**Figure 2-12: Tracking from file - Settings**

- **Video File** - Select the raw data video file that you would like to use for tracking the frames. SCENECT raw data video files have the file extension .oni and can usually be found in the scans folder of your scan project.

- **Max. Range / Color Mismatch Filter / Post processing Settings** – same settings as for the live tracking. See chapter 2.4.1 for more information.

- **Start** – Save your settings and start tracking from the selected file.

- **Cancel** – Discard unsaved changes and close the settings dialog.

- **Apply** – Save your changes. To close the settings dialog without starting tracking, press cancel afterwards.

2.5.2. Tracking from File

Start tracking from a video file with

- the Tracking from File button in the toolbar. You will be prompted to select a video file from your hard disk.

- the Start button in the Tracking from File – Settings dialog

- with Operations ▶ Tracking from Sequence File from the context menu of a sequence folder in the structure view (this will create a new sequence; the already available sequence will not be changed).
A new sequence with the name of the video file will be added to the workspace and the split window will show up with the point cloud on the left and the video picture on the right (see chapter 2.4.2 for more information). The video will be played back on the screen and the frames will be tracked without user interaction.

You may test tracking from the demo video file which was installed with SCENECT and which is available under C:\Users\YOUR_USER_NAME\Documents\FARO. When tracking from the demo video file, you should set the maximum range to 1.8m.

2.6. Workspace Structure

Once the recording of a sequence is complete you will get the following structure in the project’s workspace:

Folder **Scans**: Contains all recorded sequences.

**Sequence folder** (here “SCENECTRecordingSequence1”): Contains all the frames, snapshots and other objects of a single sequence.

Folder **Frames**: contains all the captured key frames.

Folder **Snapshots**: Contains the snapshots.

Object **Trajectory**: represents the path of the recording device.

Documentation object **History**: Provides information about the sequence (for example, the recording duration, the number of key frames and recognized features, or the applied registration steps). A yellow traffic light indicates that frame-to-frame tracking might have been inaccurate during live tracking (mostly because of a low performance system used for recording). In this case it is recommended to re-track the frames from the recorded video file.
3. Post Processing

3.1. Viewing the Recorded Results

There are three view types to display the recorded data:

- **planar view**,
- **quick view**
- **3D view**.

While the planar view and the quick view are the views to examine single frames only, the 3D view is not limited to display the scan points of a single frame. It enables combined viewing of all the frames and objects in your project.

You may change the behavior and the look of the views in the visibility setting that are available by right-clicking into the view and selecting **Visibility Settings** from the context menu.

---

For more information on the available view types and their visibility settings, see chapter “Exploring Scan Data and Objects” in the SCENE manual or in the online help under **Help > Contents**.

---

3.1.1. Viewing Frames with the Planar View and the Quick View

Single frames are best viewed and analyzed in the planar view but can also be displayed in the quick view or the 3D view.

To open the **planar view** of a frame, right-click it in the structure view and select **View > Planar View** in the context menu.

![Figure 3-1: Planar view of a frame](image)

Blue colored areas symbolize areas without scan points (areas where scan points have been removed by filters or areas without scan points due to limited range).
The planar view is mainly used to create reference objects. Reference objects are needed for the registration of two or more sequences. For more information, see chapter 3.5.

3.1.2. Viewing Scan Points with the 3D View

The 3D view is not only limited to display scan points of a single frame. It provides combined viewing of scan points of more than one frame, of an entire sequence or the entire workspace.

In the 3D view two types of scan points can be displayed:

- The scan points of the frames as they were recorded. They are organized in a row column order. Frames have to be explicitly loaded to the memory in order to be displayed in the 3D view.

- The scan points of so called scan point clouds which are an alternative representation of the scans and have to be created from the single scans. Scan point clouds are organized in a spatial data structure that facilitates fast visualization of scan points and automated point loading based on point visibility. The points of a scan point cloud do not have to be explicitly loaded into the memory in order to be displayed in the 3D view.

For visualization purposes it is recommended to create scan point clouds from the frames with Operations ▶ Point Cloud Tools ▶ Create Scan Point Cloud(s) from the context menu of a frame or a frames folder.

For more information on working with scan point clouds, see chapter "Working with Scan Point Clouds" in the SCENE manual or in the online help under Help ▶ Contents.

In the 3D view, the original points of the frames have priority over the points of scan point clouds, i.e. the points of loaded frames will be displayed instead of the points of the related scan point clouds. If you want to display and work with the points of the scan point clouds you must unload the frames first and if you want to display and work with the points of the frames you must load them into the memory.

Load frames into the memory with the command Load all scans in the context menu of the sequence folder or the frames folder. You may load / unload single frames by enabling / disabling the Loaded option in the context menu of the frames.

Open the 3D view of a frame, sequence or the workspace with View ▶ 3D View in their context menu.

The 3D view is used just like the other views. In addition, in the 3D view you can position yourself at arbitrary positions in space and have a look at the scan points and CAD models. The mouse is used to define the turning movements you want to perform, and with the keyboard you define the actual movement in space. When you have selected the fly mode of the observer-based navigation the cursor keys left, right, up, and down move you to the left, the right, forward, and downwards. The keys page-up and page-down move you up and down. In addition, you can press the shift key to accelerate movements. The walk mode of the observer-based navigation is similar to the fly mode but the z-value cannot be changed by walking forward. The walk mode is e.g. very useful to limit movement to a level of a building.

When you have selected object-based navigation, the cursor keys define how the objects move, whereas it appears you stand still. You can adjust the speed of the movement and the behavior of the mouse wheel under Tools ▶ Options ▶ Navigation. By default the rotation of the 3D view is stabilized by a locked Z-axis. Turn this behavior off under Tools ▶ Options ▶ Tab Navigation ▶ Snap to Z-axis. This results in an unlocked Z-axis and thus in a completely free rotation of the 3D view.
Figure 3-2: 3D view of a sequence

The orange line symbolizes the camera path (trajectory).

Recommended 3D view settings for displaying Kinect or Xtion scan points:

- Set the rotation point near the center of the captured scene: select 🌋 from the 3D toolbar and click on a point in the 3D view to set the rotation point.
- SCENECT point clouds are best viewed with the object based navigation mode: Select 🌋 in the 3D View toolbar.
- Use the smallest displayed scan point size: select 🌋 in the 3D toolbar.
- Disable gap filling: deselect 🌋 in the 3D toolbar.
- Hide the symbols for the sensor positions: right click in the 3D view and select Visibility Settings from the context menu. On tab Extra disable Scan positions.
- If the 3D view looks distorted switch to the orthographic view: right click in the 3D view and select Camera ➤ Orthographic from the context menu.

For more information on navigating in the views and the available visibility settings, see chapter “Exploring Scan Data and Objects” in the SCENE manual or in the online help under Help ➤ Contents.

3.2. Applying Additional Registration Steps to the Frames of a Sequence

Coarse Registration, Loop Registration and Fine Registration have already been described in chapter 2.4.1. If they were not enabled in the tracking settings and thus not automatically applied after recording of a sequence you may apply them to the frames of the sequence at any time later. Apply them
- by selecting the sequence folder and executing the appropriate commands from the SCENECT menu

- or with Operations ➤ Registration ➤ Coarse Registration / Loop Registration / Fine Registration from the context menu of the sequence folder.

![Image](image.png)

**Figure 3-3: Apply additional registration steps**

- Note: Fine registration should be applied to the sequence after coarse registration and loop registration.

- Fine registration does not always improve the registration of the frames. It is recommended to save your project before applying fine registration. If the results are not satisfactory you will then be able to discard the changes made by the fine registration.

### 3.3. Color Smoothing

Color Smoothing has already been described in chapter 2.4.1. If it was not enabled in the tracking settings and thus not automatically applied after recording of a sequence you may apply it to the frames of the sequence at any time later.

Apply color smoothing

- by selecting the sequence folder in the structure view and executing the appropriate command from the SCENECT menu

- or with Operations ➤ Color / Pictures ➤ Smooth Color from the context menu of the sequence folder.
Note: Color Smoothing should be applied to the sequence after coarse or loop registration.

3.4. Deleting Scan Points

You can modify scan points of your scan project by manually deleting unwanted scan points.

To delete the scan points open the 3D view of a sequence or the workspace and select the area to be deleted. Depending on the selection tool, you can select the points of the frames or the points of the scan point clouds (if available).

If you have used the polygonal selection tool to select the scan points from the frames, right-click the point selection and select one of the available delete operations.
If you used one of the selection tools to select points from the scan point clouds ( لديك أو أدخل الصورة)، right click the selection and use **Current Selection ▸ Delete** from the context menu.

Frames and scan point clouds are closely related to each other. Certain changes to the related frames will also have an effect on the scan point clouds and vice versa:

- The deletion of points in a scan point cloud will also be applied to the associated scan.
- When points are deleted or otherwise modified in the scan, the scan point cloud of this scan will be removed. If the scan point cloud is part of the shared data of a scan project, it will be automatically recreated after the next sharing (when working on a local workspace) or saving (when working on the scan project). To apply point modifications in a scan to the scan point cloud without sharing, when working on a local workspace, recreate the scan point cloud manually.

**Please note** that frames have to be loaded in order to apply delete commands to their points and they have to be unloaded in order to apply delete commands to the points of the corresponding scan point clouds. For more information, see chapter 3.1.2 or the online help under Help ▸ Contents

Delete operations can also be applied to the points of the project point cloud (if available). For more information, please see chapter 3.6.

### 3.5. Registering Sequences

The key frames within a sequence are aligned to each other when they are recorded, which means that the spatial relationship between them is initially known.

If you have several sequences in your workspace, the spatial relationship between these sequences is initially unknown; every sequence only knows its own coordinate system. By registering two or more sequences the spatial relationship between them will be determined and they will be merged into a single coordinate system. Each sequence (and their key frames) is placed in a correct spatial relationship with the other sequences.
Registering may be done manually with the **correspondence view** or automatically by means of **reference objects** like planes or distinctive points that are common in the different sequences. These reference objects have to be created from the data of selected key frames in each sequence. Given that there is enough overlap and that there are enough corresponding targets in the sequences which you would like to register, registration should be possible.

If you open a 3D view of your workspace (select **View ➤ 3D View** from the context menu of the workspace in the structure view) you will see that the position of the recorded sequences does not initially match.

![Figure 3-6: Not registered sequences in 3D view](image)

This manual will not describe registration in detail. It will describe the standard way of registering sequences recorded with the Kinect or the Xtion. For detailed information about registration you should have a look at chapter “Registering Scans” in the SCENE manual.

### 3.5.1. Registration with Reference Objects

As already mentioned, you need reference objects (also called references or reference objects) that are common in the two sequences which you would like to register. These reference objects have to be manually extracted from the point data of the recorded key frames. If there are at least 3 corresponding reference objects between the two sequences you would like to register, it is mathematically sufficient to calculate their spatial relationship; 3 is the mathematical minimum but a greater number may improve registration results.

Reference object types which can be used to register sequences recorded with the Kinect or the ASUS Xtion are natural references, such as planes, slabs, pipes, corner points or other distinctive points.
Natural references should meet the following requirements:

- They should be easily and clearly visible in the frames.
- Do not use references with symmetric positions or on a plane (vary elevation).
- Avoid a linear reference alignment.
- References must be included in more than one sequence. A reference which is only available in one sequence is useless for registration.
- The distance between references should not be smaller than 1m.
- The distance between reference and sensor should not be too large.
- Generally, point references are more reliable than planes, slabs or pipes.

To create reference objects follow the steps below:

1. In case there are sequences in the Scans folder that should not be registered with the other sequences, remove them from the Scans folder, e.g. by moving them into another folder that is not a child of the Scans folder.

2. Pick key frames (frames recorded from the overlapping area of the two sequences) with common reference objects from each sequence.

- The 3D view of each sequence (open it with View ➤ 3D View in the context menu of the sequence folder) is a good tool to find key frames with overlapping areas. Selecting a key frame in the structure view will highlight its points in the corresponding 3D view and might help to identify key frames with overlapping areas in the different sequences.
- Select key frames with small distances between reference object and sensor.

3. Open the planar view or the quick view of the selected key frames: select View ➤ Planar View or View ➤ Quick View from the context menu of the frame (objects cannot be created in the 3D view).

4. The reference objects must be extracted from the data by selecting the relevant points in the view and performing an object fit. To do this, identify and mark the area in the key frame that contains the selected reference object and determine the object type to be created. There are two ways to mark the relevant scan points and create reference objects: with the object marker tool or from a selection of scan points:

   - With the object marker:
     - First select the object type you want to create from the object marker tool bar:

   ![Object marker tool bar](Figure 3-7: Object marker tool bar)

   - For recordings made with SCENECT, recommended object types are natural targets like planes, slabs or points. Spheres, checkerboard or circular flat targets are artificial targets manually placed into the scan environment. They are commonly used in scan projects done with high resolution scanners.
Once the object type is selected, click on the appropriate point(s) in the planar or quick view of the frame. The object will then be automatically extracted from the point data.

![Figure 3-8: Plane fitted with the object marker tool](image)

- From a selection of scan points:
  - First select a selection tool from the selection tool bar:

![Figure 3-9: Selection Tool Bar](image)

- Once the selection tool is selected, mark the points of interest in the planar or quick view.
Then let SCENECT fit the object from the point selection: Right click on the selection in the view, select **Create Objects** from the context menu and the object type you want to create.

**Figure 3-10: Polygon selection made to fit a plane on the floor**

**Figure 3-11: Create a plane from the selection**
• Repeat this step for other objects until you have enough corresponding reference objects in the sequences.

5. The created reference objects will be added to the workspace. They are available as a child of the corresponding frame:

![Frame 000574]

Figure 3-12: fit objects in structure view

The quality of the object fit is symbolized by the traffic light. Green means that all the quality criteria are met. The Amber shows that at least one quality criterion is somewhat compromised and red means that at least one criterion is seriously compromised. If the fit of your objects shows a red traffic light you may try the following:

• Delete the object and try another fit with a new point selection.

• Try to find the same reference object in another frame of the same sequence and try to create it in this frame. Maybe there are frames with smaller object to sensor distances.

• Try to find other reference objects and use them for registration instead.

6. Once enough reference objects have been fitted in all the sequences to be registered, you can start the registration process: Right-click the Scans folder and select **Operations ➤ Registration ➤ Place Scans Auto** from the context menu.

![Figure 3-13: Place scans auto]

7. After a short computation, registration should be complete. The quality of the registration results may be checked in

• the scan manager that is now available in the workspace under the scans folder

• the 3D view of the workspace or the scans folder.
If registration is not good enough or failed you may try the following:

- Check and improve the fit quality of your objects as described above.
- Check whether sufficient reference objects have been found as corresponding in the different sequences. Reference objects with correspondence relationships to other references are marked with a C in their icon in the structure view. E.g. .
- You should have at least four or five corresponding reference objects between sequences. A higher number may improve the results.
- Generally, correspondences between point references are more reliable than between planes, slabs or pipes.
- You might have to decrease the quality criteria for the detection of corresponding reference pairs. Go to **Tools ▶ Options ▶ Matching ▶ Place Scans Settings** and move the slider in the dialog to the left. Apply registration again afterwards.

---

**Figure 3-14: Registered sequences in 3D view**
**Figure 3-15: Place scans settings**

- Make sure that **Find correspondences when placing scans** is enabled in the place scans settings (see screenshot above).

- If correspondences between reference objects are not automatically found you may try to manually create (or force) correspondences between the reference objects. Basically, there are two ways to manually create a correspondence between references:
  
  - Manually name the reference objects in a sequence according to their counterparts in the other sequences. You can rename objects in their properties dialog on tab **General** (open the properties dialog by selecting **Properties** in the context menu of the object). This forces correspondences between identical named reference objects. Then use the registration command **Operations ▶ Registration ▶ Place Scans (Force by Manual Target Names)** in the context menu of the scan folder which forces correspondences by name.

  - Arrange the sequence in the correspondence view, so that its references are positioned next to their counterparts in the other sequences. Then update the correspondences. This will create correspondences between the neighboring references. For more information, see chapter 3.5.2.

- To identify problematic target pairs you may have a look at the Scan Manager or the Correspondence View.

- If two objects are found to be corresponding, but in reality they aren’t, you may mark their correspondence relationship as wrong in the Scan Manager. Correspondences marked as wrong are named “anti-correspondence”.

- If you have applied one or more of the above mentioned improvements, you can reapply registration with **Operations ▶ Registration ▶ Place Scans Auto.**
If automatic registration failed or did not deliver satisfying results you may also try to manually place the sequences with the correspondence view. For more information, see chapter 3.5.2.

For more information on the correspondence view, please see chapter “Registering Scans” in the SCENE manual.

3.5.2. Correspondence View

The correspondence view is a tool that enables manual placement and registration of sequences in an easy way if automatic registration fails. In the correspondence view you can manually move and rotate sequences so that they are correctly aligned to each other.

Open the correspondence view with View ▶ Correspondence View in the context menu of the Scans folder that contains the sequences you would like to register.

In the correspondence view, the scan points of a sequence are displayed in unique colors to distinguish between the different sequences.

![Figure 3-16: Correspondence view](image)

Labels allow easy identification of individual sequences. Clicking the label will select the related sequence. When clicking the symbol on the right of the label, the sequence gets excluded (invisible) or included (visible).

To move or rotate a sequence, select it in the structure view or click on its label. The manipulator tool which allows moving and rotating the sequence will show up.
The manipulator tool consists of move- and rotate-handles. Clicking on a move handle (white arrows) and dragging it will move the sequence within two dimensions. The two dimensions depend on which move handle was clicked. Clicking and dragging a rotate-handle (red, green or blue circle lines) will rotate the sequence around the corresponding axis.

There are three buttons that allow correction of wrong manipulations:

- The button **restore previous transformation** can be used to move the sequence back to the previous location.
- The button **reapply transformation change** is used to reapply a transformation, which was reverted.
- The button **restore initial transformation** finally restores the initial transformation the sequence had when the manipulator was created.

These buttons are available in the correspondence view toolbar and also in a flying toolbar that appears after every manipulation.
Manipulators can be resized via the “+” and “−” keys on your keyboard or the and buttons of the correspondence view toolbar.

It is easier to use the manipulators while looking at the scene from the top, right or back, using the buttons in the 3D View toolbar.

Don’t forget to manipulate the level of the sequence, too. This is done best when looking on the scene from the side.

Please note that deselecting a sequence will cause the manipulator to disappear and clear all previous transformations.

In the correspondence view all corresponding objects are connected by colored lines. To visualize these correspondences you can drag a sequence away from the others using the manipulator. To move the sequence back in place, simply use the restore previous transformation button.

![Figure 3-19: Correspondences visualized by lines.](image)

If you think that the sequences are in their right place, you may confirm their placement with the Update button . Confirming the placement will start a special correspondence search between near references. All of the sequence’s old correspondences will be removed in this step. The newly detected correspondences will get forced afterwards. Please note that the update button only confirms the correspondences to near references, not the placement of the sequence itself.

The update button will search correspondences for all selected sequences. Using update with no sequence selected will use all included (visible) sequences for correspondence search. Excluded (invisible) sequences are always ignored in this type of correspondence search.

When using the update button to evaluate correspondences, verify the results afterwards by checking the correspondence lines. The number of found correspondences is also displayed in the status bar after clicking the update button.

If no or not enough correspondences are found, check these common errors:
- Sequences aren’t placed properly by level. This can be checked by using a viewpoint from the side.
- Sequence placement wasn’t precise enough. Try placing the sequences more precisely.
- Sequences don’t have enough references in the overlapping area. Open a planar or a quick view and identify additional references.
- Sequences don’t have an overlapping area. Use additional sequences to fill the missing gaps between them.

When the sequences are placed in their right position and the correspondences have been updated, apply registration with the \texttt{\textbullet\textbackslash Registration} button in the correspondence toolbar or with \texttt{Operations \textbullet\textbackslash Registration \textbullet\textbackslash Place Scan(s)} in the context menu of the scan folder.

It is \textit{strongly recommended} to use the update button before starting registration to confirm and force correspondences with the current placement. Without using update, the registration will completely ignore the current positions of the sequences and may mix up their manual placement.

When closing the correspondence view after at least one registration was performed, a message box may appear and ask whether to force all correspondences. Answer with Yes if the result of the registration was satisfying to fix the correspondences.

For more information on the correspondence view, please see chapter “Registering Scans” in the SCENE manual.

\section*{3.6. Creating a Project Point Cloud}

The project point cloud consists of the 3D points of all the sequences within your workspace and can be seen as a comprehensive 3D point cloud of your complete scan project. The project point cloud is typically created from all the single frames in your project after they have been processed and the sequences have been registered.

The project point cloud is optimized for fast visualization of large amounts of scan points in the 3D view and is organized in a spatial data structure that facilitates fast visualization of the scan points. The amount of points in a project point cloud can be enormous. Unlike single frames, such large amounts of points cannot always be loaded into physical memory at once. Therefore, the points of the project point cloud are automatically loaded and visualized on demand based on the camera position and point visibility.

Create the project point cloud with the button \includegraphics[width=1.2em]{image.png} in the project toolbar or under \texttt{File \textbullet\textbackslash Scan Project \textbullet\textbackslash Create Project Point Cloud}. This settings dialog will show up:
For the creation of the project point cloud two point filters are available. Each of these filters will reduce the overall point count by eliminating different types of unwanted points.

**3D Stray Point Filter** - The 3D stray point filter removes stray points from the project point cloud, creating a cleaner overall look.

**Eliminate Duplicate Points** - The filter removes duplicate points that exist in overlapping areas between the frames. These overlapping areas can be optimized by removing some of the duplicate points. This filter can improve the visual quality of your project point cloud significantly while reducing overall point count and therefore improving interactivity and loading times of the point cloud. With the search radius slider you can adjust the distance threshold for point elimination. The default setting should be sufficient for almost all scenarios. Adjust the search radius slider to the right to enlarge the search radius and increase the number of eliminated points. This may help to reduce point count when your registration is not very accurate. Adjust the search radius slider to the left to reduce the number of eliminated points. This can be useful if too many points have been deleted by this filter in previous point cloud iterations.

**CPU Load** - The slider allows adjusting the number of (logical) CPU cores used for parallel computation throughout certain steps of the point cloud creation process. The more cores are used, the sooner the point cloud creation may be finished. Please note that less performance is available for other programs running on the machine when increasing the number of CPU cores.

**Temporary Data Folder** - While point cloud creation all frames in the project will be loaded successively; their point data will be processed and transformed into a temporary representation. This temporary data will be stored inside the temporary data folder. Please do not delete, move or copy any of these files during point cloud creation or the process might fail. The temporary data will be deleted automatically once the process is complete.
Click **OK** to start the creation. Depending on the size of your project, this might take up some time.

Once the point cloud has been created, you can view it by opening the 3D view of the workspace (View \[3D View\] in context menu of the workspace or by clicking the \[3\] button in the standard toolbar).

For more information on the project point cloud, please see chapter “Working with the Project Point Cloud” in the SCENE manual.

### 3.7. Analyzing the Scanning Results

There are several possibilities to analyze the scanned reality in SCENECT:

- You can use the 3D view to compare the scanned reality with existing CAD models.
- You can measure distances between objects and points.
- You can visualize distances and scales in the 3D view.

For more information, please see chapter “Analyzing Scan Points” in the SCENE manual or in the online help under Help \[Contents\].

### 3.8. Exporting

You may export the recorded points from the sequences into different file formats in order to use them in other applications such as CAD systems. The following formats are available: E57, VRML, DXF, XYZ text, XYZ binary, IGES, PTS, PTX, PTC and POD (Pointools).

To export the points of a sequence right click on the sequence folder or on the Scans folder and select **Import / Export \[Export Scan Points\]** from the context menu. A dialog will show up to select the target file format.

For more information on exporting scan points and the available file formats, please see chapter “Exporting Scan Points” in the SCENE manual or in the online help under Help \[Contents\].
4. Calibrating the Sensor

It is recommended to calibrate your sensor device at least once before using it with SCENECT. Calibration might increase tracking quality and color accuracy of your sensor device. SCENECT calibrates the color camera of the sensor device.

Follow the steps below to calibrate your sensor:

1. Attach the sensor to the USB port of your computer.
2. Open SCENECT
3. Open a project
4. Print the calibration pattern needed for the sensor calibration:
   - Open it in the SCENECT menu under Calibration ➤ Print Pattern A4 / Print Pattern USLetter. Choose one of the two available formats. Make sure not to scale the pattern when printing (in the Adobe Reader settings set Page Scale to none).
5. Put the printed pattern on a flat surface, e.g., the desk, and fix it with adhesive tape.
6. Take your sensor and start calibration with Calibration ➤ Start from the SCENECT menu. A window with the video picture of the sensor and a progress dialog will show up.
7. Take 30 images of the pattern from different positions: It is important to take pictures from the pattern from different distances, orientations and positions. Vary as much as possible. Whenever the video picture is shown in color and colored lines are visible, the pattern is detected and SCENECT is ready to take an image.

8. Press F7 to take an image. Try not to move the sensor while taking the image.
9. After the last image, calibration will be calculated.

If you have more than one sensor device, calibrate each device. When recording, SCENECT will recognize the connected sensor and apply the appropriate calibration.
5. Hints & Tips

- After plugging in the Xtion or Kinect wait until the computer has detected the device. If scanning starts too early, initialization of the device may fail.

- If the drivers for the Kinect or the ASUS were already installed on your system and the devices are not recognized by SCENECT, you should uninstall the drivers and re-install them by executing the SCENECT setup.

- The Microsoft Kinect and the ASUS Xtion might not work on some USB 3.0 ports. If the device is not recognized by your system when plugging into a USB 3.0 port, plug it into a USB 2.0 port of your computer. USB 3.0 ports can be identified by their blue connector.

- When using a notebook in battery mode: Set the power management of your system to maximum performance.

- If you have many sequences in the workspace, unload some of them to reduce memory consumption.
This Software License Agreement is part of the operating manual for the product and software system which you have received from FARO TECHNOLOGIES INC. (collectively, the “Licenser”). By your use of the software you are agreeing to the terms and conditions of this Software License Agreement. Throughout this Software License Agreement, the term “Licensee” means the owner of the System.

I. The Licensor hereby grants the Licensee the non-exclusive right to use the computer software described in this Operating Manual (the “Software”). The Licensee shall have no right to sell, assign, sub-license, rent or lease the Software to any third party without the Licenser’s prior written consent.

II. The Licenser further grants the Licensee the right to make a backup copy of the Software media. The Licensee agrees that it will not decompile, disassemble, reverse engineer, copy, transfer, or otherwise use the Software except as permitted by this Agreement. The Licensee further agrees not to copy any written materials accompanying the Software.

III. The Licensee is licensed to use the Software only in the manner described in the Operating Manual. Use of the Software in a manner other than that described in the Operating Manual or use of the Software in conjunction with any non-Licenser product which decompiles or recompiles the Software or in any other way modifies the structure, sequence or function of the Software code, is not an authorized use, and further, such use voids the Licenser’s set forth below.

IV. The licensed software is expressly in an experimental state. It is not meant for any commercial use. FARO does not give any warranties for functionality nor provide any technical support for the licensed product. FARO retains the right withdraw the software at any time without further warning. FARO does not allow any distribution or other than private use copy of the software.

V. IN NO EVENT WILL THE LICENSER BE LIABLE FOR DAMAGES, INCLUDING ANY LOST PROFITS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, NOT WITHSTANDING THAT THE LICENSER HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, THE LICENSER WILL NOT BE LIABLE FOR ANY SUCH CLAIM BY ANY OTHER PARTY.

VI. In the event of any breach by the Licensee of this Agreement, the license granted hereby shall immediately terminate and the Licensee shall return the Software media and all written materials, together with any copy of such media or materials, and the Licensee shall keep no copies of such items.

VII. The interpretation of this Agreement shall be governed by the following provisions:

a. This Agreement shall be construed pursuant to and governed by the substantive laws of the State of Florida (and any provision of Florida law shall not apply if the law of a state or jurisdiction other than Florida would otherwise apply).

b. If any provision of this Agreement is determined by a court of competent jurisdiction to be void and non-enforceable, such determination shall not affect any other provision of this Agreement, and the remaining provisions of this Agreement shall remain in full force and effect. If any provision or term of this Agreement is susceptible to two or more constructions or interpretations, one or more of which would render the provision or term void or non-enforceable, the parties agree that a construction or interpretation which renders the term of provision valid shall be favored.

c. This Agreement constitutes the entire Agreement, and supersedes all prior agreements and understandings, oral and written, among the parties to this Agreement with respect to the subject matter hereof.

VIII. If a party engages the services of an attorney or any other third party or in any way initiates legal action to enforce its rights under this Agreement, the prevailing party shall be
entitled to recover all reasonable costs and expenses (including reasonable attorney’s fees before trial and in appellate proceedings).

Implementation Notes

Apache

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.
"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:
(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and

(b) You must cause any modified files to carry prominent notices stating that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NONINFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

paintlib Library

SCENECT contains paintlib code. paintlib is copyright (c) 1996-2000 Ulrich von Zadow.

LibTIFF Library

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

JPEG Library

This software is based in part on the work of the Independent JPEG Group.
KissFFT Library

Copyright (c) 2003,4 Mark Borgerding

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the author nor the names of any contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Open Source Computer Vision Library

Copyright (C) 2000-2008, Intel Corporation, all rights reserved.
Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved.

Third party copyrights are property of their respective owners.

- Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

The name of the copyright holders may not be used to endorse or promote products derived from this software without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and any express or implied warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall the Intel Corporation or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

GPL (GNU General Public License)

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for them if you wish), that you
receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to copy or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language, one that is widely used among developers working in that language.
The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code interpreter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocably provided the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.


You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided that you also meet all of these conditions:

a) The work must carry prominent notices stating that you modified it, and giving a relevant date.

b) The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the requirement in section 4 to "keep intact all notices".

c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting copyright are not used to limit the access or legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.

b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network server at no charge.

c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For example, a product is a consumer product even if the manufacturer intended it to be used in a business setting.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.
7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:

a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works containing it; or

c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the original version; or

d) Limiting the use for publicity purposes of names of licensors or authors of the material; or

e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, or a notice indicating where to find the applicable terms. Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.


You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under applicable patent law.


If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPTIONS WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS

Written Offer

If you, the owner of the scanner, like to get a copy of the source code of GPL covered parts of the scanner's firmware, please contact our support team support@faroeurope.com. This offer is valid for three years and valid for as long as FARO offers spare parts or customer support for this product model.

LGFL (GNU Lesser General Public License)

SCENECT includes the following applications and libraries, which are covered by the LGPL:

- libusb
- Linux API
- DirectFB
- Eigen
- OpenNI

GNU LESSER GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a) under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still operates, and performs whatever part of its purpose remains meaningful, or

b) under the GNU GPL, with none of the additional permissions of this License applicable to that copy.


The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or fewer lines in length), you do both of the following:

a) Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b) Accompany the object code with a copy of the GNU GPL and this license document.


You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a) Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b) Accompany the Combined Work with a copy of the GNU GPL and this license document.

c) For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference directing the user to the copies of the GNU GPL and this license document.

d) Do one of the following:
0) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

1) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user’s computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.

e) Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install and execute a modified Combined Work produced by recombining or relinking the Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)


You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this License.

b) Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy’s public statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

Written Offer
If you, the owner of the scanner, like to get a copy of the source code of LGPL covered parts of the scanner’s firmware, please contact our support team sup-port@faroeurope.com. This offer is valid for three years and valid for as long as FARO offers spare parts or customer support for this product model.

GEOTRANS
The product was developed using GEOTRANS, a product of the National Geospatial-Intelligence Agency (NGA) and U.S. Army Engineering Research and Development Center.

Trademarks
FARO and FARO Laser Scanner Focus are registered trademarks or trademarks of FARO Technologies Inc. All other brand and product names are trademarks or registered trademarks of their respective companies.

Microsoft, Windows, Windows 7, Kinect and Xbox are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

ASUS Trademark is either a US registered trademark or trademark of Asustek Computer Inc. in the United States and/or other countries.

PrimeSense and OpenNI are Marks of PrimeSense or its affiliates.